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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these 
consultants when you need help.  To determine if you have a consultant assigned to your division or 
college, look to: http://rohan.sdsu.edu/~facstaff 
 
Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to provide all 
students, faculty, and staff with "baseline" access to information resources via networks, training in the 
uses of baseline hardware and software systems, and ongoing professional and technical support for 
utilization of computer resources at San Diego State University.  You can access the BATS Web Page 
by pointing your browser to: http://rohan.sdsu.edu/~bats/ 
 
Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to answer 
your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

�

Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
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ONSCREEN 
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If The Office 
Assistant Is OFF 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There are many different ways to find help when you have questions 
about Microsoft Access.  The onscreen Help menu is your main source 
of “how to” information about the database application. 
 
Help can be accessed two ways.  Your Office Assistant may be turned 
on or off. 
 
 
To view onscreen help, click on Help on the Menu Bar.  The Help menu 
will pull down. Once the menu is displayed, select one of the following 
options: 
 
Microsoft Access Help 
 
When you select this option, you will see a help screen with three tabs. 
 

• Contents 
 

Here you will find a listing of help topics organized by category.  
Double click on the desired topic or subtopic and the appropriate 
page in the on-line manual will display. 

 
• Answer Wizard 

 
Type your question in the window, click on Search, and the 
Wizard will list related topics.  Double click on the desired topic 
and the appropriate page in the on-line manual will display. 

 
• Index 

 
Type in a key word in window 1 and a list of topics will display 
in window 2.  Double click on the desired topic and the 
appropriate page in the on-line manual will display. 

 
Show The Office Assistant 
 
The Office Assistant will appear.  Type your question in the window, 
click on Search, and the Assistant will list related topics.  Double click 
on the desired topic and the appropriate page in the on-line manual will 
display. 
 
What’s This? 
 
Select this option and your cursor will include a Question Mark next to 
it.  Click on anything on the screen and Access will provide an 
explanation of the item. 
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If The Office 
Assistant Is ON 

 
 

 

Office On The Web 
 
Selecting this option will launch your browser and you will be 
connected to the Microsoft Web Site.  Here you can search for an 
answer to your question. 
 
 
You can launch the Office Assistant by clicking on the Microsoft 
Access Help button. 

 
 
Type your question in the window, click on Search, and the Assistant 
will list related topics.  Double click on the desired topic and the 
appropriate page in the on-line manual will display. 
 
View Onscreen Help 
 
To view onscreen help, click on Help on the Menu Bar.  The Help menu 
will pull down. Once the menu is displayed, select one of the following 
options: 
 
Microsoft Access Help 
 
The Office Assistant will appear.  Type your question in the window, 
click on Search, and the Assistant will list related topics.  Double click 
on the desired topic and the appropriate page in the on-line manual will 
display. 
 
What’s This? 
 
Select this option and your cursor will include a Question Mark next to 
it.  Click on anything on the screen and Access will provide an 
explanation of the item. 
 
Office On The Web 
 
Selecting this option will launch your browser and you will be 
connected to the Microsoft Web Site.  Here you can search for an 
answer to your question. 
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Make the Table 
 
 

 

You can create a new table by using all or part of the data in one or 
more tables.  
 
Make-table queries are helpful for: 
 

• Creating a table to export to other Microsoft Access databases.  
• Creating reports that display data from a specified point in time.  
• Making a backup copy of a table. 
• Creating a history table that contains old records.  
• Improving performance of forms and reports based on multiple-

table queries or SQL statements. 
 
There are two steps involved in the process.  First, you must convert the 
query from a select query to an action query.  Then you create the table. 
 
 
Once you have created the initial query and run it to ensure that the 
proper records are selected: 
 
1. Open the query in Design View. 
 
2. Click on the Query on the Menu Bar. 
 
3. Select the Make-Table Query option. 
 
4. Enter a name for the new query and indicate whether it is to reside in 

the current or another database. 
 
5. Click on OK .  The existing Select Query is converted to an Action 

Query. 
 
 
Once the Action Query is created, you can create a new table. 
 
1. Run the Action Query and create the new table by clicking on the 

red exclamation point icon on the toolbar. 
 
2. You will receive a message that the query will paste a number of 

rows in the new table.  Click on Yes to continue the operation. 
 
3. Close the query. 
 
4. At this point you will want to view the table in Design View, and set 

any properties that you need, and assign a Primary Key if desired. 
 
5. Finally, you will want to establish Relationships for the new table (if 

applicable). 
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Creating the Query 

 
 
 
 
 
 
 
 
 

 
 

 
Convert to Action Query 

 
 
 
 
 

 

You can update data in tables using the Update Query.  For instance, if you 
had a database that included company names, and if one of the companies 
changed its name, you could update all of the records to reflect the new 
name using an Update Query. 
 
There are three steps involved in the process.  First, you must create a query 
to update the records.  Then you convert the query from a select query to an 
update query.  Finally, you run the query to change the records. 
 
To create the initial query: 
 
1. Open a new query in Design View. 
 
2. Select the table or tables containing the field of information that you 

want to update. 
 
3. Double click the field name that you want to update.  This adds the field 

to the query grid. 
 
4. Enter the existing value in the Criteria row. 
 
5. Run the query by clicking on the View button to ensure that you have 

correctly selected the records to be updated. 
 
6. Click on the View button once more to return to Design View. 
 
7. Click on Query on the Menu Bar.  
 
8. Select the Update Query option.  A new row (Update To:) is added to 

the query grid. 
 
9. Enter the new value in the Update To: row.  
 
10. Run the query by clicking on the red exclamation point button on the 

toolbar.  A message box indicates the number of records to be updated. 
 
11. Click on Yes to update the records. 
 
12. Close the query. 
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Changing Tab Order 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

Remove a Field 
from the Tab Order 

 
 
 
 

 
 
 
 
 
 

Display Current Date 
And/Or Time 

 
 
 
 
 
 
 
 
 
 
 
 
 

A variety of tools are available for you to use when you are working 
with forms. 
 
When you add fields to a form, Access defaults the tab order to be the 
order in which the fields were added.  Sometimes you may want to 
change this order.  To change tab order: 
 
1. Open the form in Design View. 
 
2. Click on View on the Menu Bar and select Tab Order.  The Tab 

Order dialog box will appear. 
 
3. Click on the Auto Order button  if you want to reorder the entry 

sequence going left to right across each row of fields, then top to 
bottom. 

 
4. Drag any control to a new location by clicking the button at the left 

of its name and dropping it where ever you want it to be in the 
sequence. 

 
5. Click on OK  to implement the changes you made. 
 
 
You may not want to allow a user to change a value in a displayed field.  
To do this: 
 
1. Open the form in Design View. 
 
2. Click on the field to be dropped from the Tab Order. 
 
3. Open the Properties window, and select Other Properties. 
 
4. Change the value of the Tab Stop property to NO. 
 
 
To add the current date or current time to a form: 
 
1. Open the form in Design View. 
 
2. Open the Toolbox. 
 
3. Insert a new Text Box in the desired location on the form. 
 
4. Delete the label portion of the Text Box. 
 
5. Open the properties for the Text Box. 
 
6. Select the Data Tab. 
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Add a List Box 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Alphabetize List 

 
 
 
 
 
 
 

7. In the Control Source row enter =Date() to display the current date 
or =Time() to display the current time. 

 
8. Select the Format Tab. 
 
9. In the Format Row, select the way you want the date or time to 

display. 
 
10. Select any other desired formatting options. 
 
11. Save the form. 
 
 
You can add a List Box to your form so that you can find specific 
records quickly.  To add a List Box: 
 
1. Open the Toolbox. 
 
2. Ensure that the Control Wizard button  is selected on the Toolbox. 
 
3. From the toolbox, select the List Box button and then click on the 

form to place the box.  A Wizard will start. 
 
4. Click the Radio Button next to “Find a record on my form based on 

the value I selected in my list box.”  Click the Next button. 
 
5. Select the field(s) you want displayed in the List Box. 
 
6. Size the columns if desired.  Leave the check mark in the Hide Key 

Column box. Click the Next button. 
 
7. Enter the text for the label as you want to show it on the form. Click 

the Next button. 
 
8. Click on Finish, and the Text Box will appear on your form. 
 
9. Reposition and format the Text Box and Label as desired. 
 
10. View your form in Form View and watch your form display the 

record for the name/item you select in the List Box window. 
 
 
You may want the values in the List Box to be displayed in some sort of 
order.  To set the order: 
 
1. Select the Text Box. 
 
2. View the Properties for the List Box. 
 
3. Select the Data Tab. 
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Subforms 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click in the Row Source row.  An ellipsis button will appear. 
 
5. Click on the Ellipsis button.  A SQL query will appear.  This is a 

special query that will not be listed in the Query window. 
 
6. Select the Sort row for the field you want to sort by. 
 
7. Select Ascending or Descending. 
 
8. Save and close the query. 
 
9. If you would like column headings in your Text Box, click on the 

Format tab. 
 
10. Set the Column Heads row value to YES. 
 
11. View the form in Form View and test the List Box. 
 
NOTE:  You can enter the first letter of data in the selected field and 

Access will take you to the first record in the field containing 
the letter you typed. 

 
 

A subform is a form that is contained within another form.  Subforms 
are especially effective when you want to show data from tables or 
queries with a one-to-many relationship.  For example, you could create 
a form with a subform to show data from a Student table and an Advisor 
table.  The data in the Student table is the "one" side of the relationship. 
The data in the Advisor table is the "many" side of the relationship — 
each advisor can be assigned to more than one student. 

The main form and subform are linked so that the subform displays only 
records that are related to the current record in the main form.  

When you use a form with a subform to enter new records, Microsoft 
Access saves the current record in the main form when you enter the 
data in the subform.  This ensures that the records in the "many" table 
will have a record in the "one" table to relate to.  It also automatically 
saves each record as you add it to the subform. 
 
A subform can be displayed as a datasheet or it can be displayed as a 
single or continuous form. A main form can be displayed only as a 
single form. 
 
A main form can have any number of subforms if you place each 
subform on the main form.  You can also nest up to ten levels of 
subforms.  This means you can have a subform within a main form, and 
you can have another subform within that subform, and so on. 
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Add a Subform 
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Adding a  
Tabbed Form 

 
 
 
 
 
 
 
 
 
 
 
 

There are two ways to add a Subform to a Main form: 
 
Use the Wizard 
 
1. Open the main form in Design View. 
 
2. Ensure that the Control Wizard button  is selected on the toolbox. 
 
3. Click on the Subform/Subreport tool in the toolbox. 
 
4. Click on the Main Form  where you want to subform to reside.  The 

SubForm Wizard will activate. 
 
5. To make an existing form a subform, click on the Radio Button 

next to “Use an existing form”. 
 
6. Select the desired form from the list of forms. 
 
7. Select the method of linking the forms. 
 
8. Give a name to the new Subform. 
 
9. At this point you will want to format the Subform in Design view so 

that the output is what you want. 
 
Drag and Drop 
 
With the main form open in Design View: 
 
1. Switch to the Database Window 
 
2. Select the icon of the form to be added as a Subform. 
 
3. Drag the icon to the Main form and Drop it where desired. 
 
 
The Tab Control lets you easily create multiple forms in a tabbed 
format.  Using the tabbed format you can eliminate multi-page forms. 
 
To add a Tab control to a form: 
 
1. Open the main form in Design View. 
 
2. Click on the Tab Control button  on the toolbox. 
 
3. Draw a rectangle on the main form where you want the tabbed form 

to reside.  The tabbed form will open with two tabs. 
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Adding Tabs 
 
 
 
 
 
 
 

 
Changing The 

Tab Order 
 
 
 
 
 
 
 
 
 
 

 
Deleting a Tab 

 
 
 
 
 
 

 
Adding a Subform 

to a Tab  
 

To add additional tabs: 
 
1. Use the right mouse button and click on a tab to display a contextual 

menu. 
 
2. Select Insert Page.  The new tab will be inserted to the right of the 

other tabs. 
 
 
As you develop your form, you may want to change the order of the tabs 
in the tabbed form.  To change tab order: 
 
1. Use the right mouse button and click on a tab to display a contextual 

menu. 
 
2. Select Page Order.  The Page Order window will open. 
 
3. Use the Move Up and Move Down buttons to re-order the tabs. 
 
4. Click on OK  when done.  The tabs will now display in the order you 

selected. 
 
To delete one of tabs: 
 
1. Use the right mouse button and click on the tab you want to delete 

and a contextual menu will be displayed. 
 
2. Select Delete Page.  The selected tab will be deleted. 
 
 
There are two ways to add a Subform to a tab: 
 
Use the Wizard 
 
1. Ensure that the Control Wizard button  is selected on the toolbox. 
 

2. Click on the Subform/Subreport tool in the toolbox. 
3.  

3. Click on the tab in the tabbed form where you want to subform to 
reside.  The SubForm Wizard will activate. 

 
4. To make an existing form the subform, click on the Radio Button 

next to “Use an existing form”. 
 
5. Select the desired form from the list of forms. 
 
6. Select the method of linking the forms. 
 
7. Give a name to the new Subform. 
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8. At this point you will want to format the Subform in Design view so 
that the output is what you want. 

 
Drag and Drop 
 
With the main form open in Design View: 
 
1. Add the Tab Control to the Main Form 
 
2. Switch to the Database Window 
 
3. Select the icon of the form to be added to the first tab as a Subform. 
 
4. Drag the icon to the Main form and Drop it on the first tab. 
 
5. Continue dragging and dropping until you have subforms on all the 

desired tabs. 
 

 


